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1	 Introduction

1.1	 User community and user benefits

Manufacturers who see control technology as an opportunity to differentiate 
themselves and sharpen their profile, and who also wish to take advantage of the 
wide user acceptance the resource pool available for Step®7, are best served by the 
Saia PCD® Series xx7 control system, as they can gain the most benefit from the 
high level of service and performance of the Saia PCD® and the flexibility and SPS 
expertise that we can offer.

On the other hand, system integrators with no experience of Saia PCD®s, who 
wish to use the high level of service and performance of the Saia PCD®s in one-off 
production plant projects to replace a high-performance Siemens control system (S7-
400) for cost reasons, will gain little real benefit from our Saia PCD® Series xx7. This 
is especially true where many other intelligent Siemens devices are installed, with 
interfaces that are not based on open standards alone.

We put great effort into systematic testing to ensure compatibility with the Step®7/
Higraph/SCL tools and the like. However, we cannot and do not wish to copy and test 
the characteristics and behavior of a high-performance Siemens SPS deployed as a 
control for Siemens “Total Integrated Automation”.

1.2	 Differences from other Step®7-programmable controls

Saia Burgess Controls has implemented all the CPU operating system functionality 
as firmware components. We do not use any “miracle chips”. We are therefore 
dependent on nobody, but our customers gain the advantage of rapid change/
enhancement to the operating system.

1.2.1	 Portability and compatibility

The Saia PCD® Series xx7 operating system interprets the Step®7 AWL code. This 
means that the Step®7 program can be executed in any AWL-based language such 
as KOP, FUP, Higraph, SCL or S7-Graph. Calls to Siemens-specific system functions 
(e.g. for special modules such as communication processors), or access to additional 
peripherals, may require modifications to the program. 

For more details on this and on the system functions themselves, refer to the 
Technical Information document TI 26/353 (xx7 operating system).

There is not complete compatibility. However, the Saia PCD® Series xx7 controls 
are Step®7 programmable. The main restrictions arise where specific local Simatic 
modules, communication processors or functional modules are an absolute 
requirement. Because of differences in hardware structure, these cannot be 
integrated into the xx7 system. SBC offers cost-effective alternative solutions that 
involve little engineering effort to implement. The instruction sets and component 
addresses for the xx7 controls roughly correspond to those of the Siemens 
CPU412/414. It is important to check that any Siemens system functions used are 
also available in the Series xx7 operating system. For more information, refer to the 
Technical Information document TI 26/353 (xx7 operating system). More detailed 
information on programming system functions can be found in manual “26/797 xx7 
System functions”.
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For applications that go beyond this, please contact us at:

		  mailto: support@saia-pcd.com

1.2.2	 CPU comparison

The instruction set and component addressing for the PCD1.M137 are comparable 
with the Siemens CPU 412. With the PCD2.M127/M157/M177/M487 controls, the 
instruction set is roughly equivalent to the Siemens CPU 414. There is generous 
provision of user memory. 

		  PCD1.M137 = 64 (default) / max. 128 kB (configurable)
		  PCD2.M127 = 128 kB
		  PCD1.M157 = 256 (default) / max. 512 kB (configurable)
		  PCD1.M177 = 512 (default) / max. 1 MB (configurable)
		  PCD2.M487 = 1 MB
		  PCD3.M5547= 512 kB
		  PCD3.M5447= 512 kB

Further information on memory settings can be found in manual “26/797 xx7 System 
functions”, in the section on “System configuration”.

Because of the differing command execution times, operating speeds can only be 
approximately compared. The PCD1.M137 and PCD2.M127 are about 3 times slower 
than the PCD2.M157 and PCD2.M177, which themselves achieve roughly the same 
cycle time as the Siemens CPU 315. The PCD2.M487 attains the operating speed of 
the Siemens CPU 318.

1.2.3	 How is the Saia PCD® Series xx7 configured?

Configuration of the CPU (MPI address, impulse byte, interrupt OBs, etc.) is handled 
by Simatic Manager. Updated CPU settings take effect on the next STOP->RUN 
transition.

Configuration of networks (Profibus, Ethernet) is also handled by Simatic Manager. 
Further information can be found in manual “26/798 xx7 communication facilities”.

The addressing and configuration of local I/O modules, and SBC-specific CPU 
and interface settings, are handled by data blocks generated with a free-of-charge 
software tool, the I/O Builder. You can download the I/O Builder from the Internet, 
from http://www.sbc-support.com. Detailed information on the I/O Builder can be 
found in this manual, from section 2 onwards.

1.3	 Documentation

1.3.1	 Where can I find information on the Saia PCD® Series xx7?

You will find Technical Information documents (TIs) and various manuals on the 
Saia PCD® Series xx7 on our support site. You can download these documents from 
http://www.sbc-support.com.
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1.3.2	 Overview and structure of the documentation

The summary of Saia PCD® Series xx7 documentation given below should help you 
to find the information you need outside this manual. 

Manual for
xx7 beginners
(26/835) Manual:

PCD3 Series hardware
(26/789)

Beginners

Manual:  
PCD1/PCD2 Series 
hardware (26/737)

Various other
documents at
www.sbc-support.com

Manual: xx7-specific 
aspects of the PCD3
hardware (26/836)

Manual: 
xx7 communication
facilities (26/798)

Manual: xx7-specific
aspects of the PCD1/PCD2 
hardware (26/757)

Manual: 
xx7 system functions
(26/797)

Hardware

Detailed information

Manual:
Ethernet with xx7
(26/791)

Manual:
Serial communication
with xx7 (26/794)

Manual:
xx7 webserver
(26/775)

Manual:
xx7 modem library
(26/793)

http://http://www.sbc-support.com
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2.	 Fundamentals of hardware configuration

This manual provides an overview of hardware configuration with the xx7 I/O Builder 
and the Siemens STEP®7 software.

2.1	 Introduction to hardware configuration

Configuring

By “configuring”, we mean the allocation of Saia PCD® CPUs (incl. expansion de-
vices, I/O modules and interface modules) in a station window. CPUs and expansion 
devices are represented by a configuration table that supports a fixed number of 
pluggable modules, just like the “real” CPU. 

In the configuration table, the xx7 I/O Builder automatically assigns an address to 
each I/O module. You can change the addresses of I/O modules.

A hardware data block is then generated, which can be loaded into the Saia PCD®s 
with the aid of STEP®7. You can import the configuration into STEP®7 as often as you 
like, modify it if necessary, and load it into one or more existing systems. 

At a Stop→Run transition in the CPU, the loaded configuration will be analyzed and 
applied.

Parameterizing

By “parameterizing”, we mean:

•	 Setting properties for parameterizable modules for the central assembly and for a 
network. Example: a Saia PCD® is a parameterizable module; the cycle monitoring 
time is a parameter that you can set.

•	 Setting Bus parameters and DP Master and Slave parameters for a Master system 
(PROFIBUS-DP).

You can use the xx7 I/O-Builder to parameterize SBC-specific functions of CPUs and 
communication modules (e.g. compiler functions, webserver serial interfaces etc.). A 
Configuration Data Block (CDB) is then generated, which can be loaded into the Saia 
PCD®s with the aid of STEP®7.

General CPU functions (cycle time monitoring, MPI addresses etc.) and communi-
cation settings (Profibus, TCP/IP communication etc.) are handled by the hardware 
configurator or by NetPro under STEP®7.

Most parameters are read in and analyzed after a Power On of the CPU.
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2.2	 Basic procedure for hardware configuration

Configuration window

To configure a Series xx7 Saia PCD®, you use two windows in the xx7 I/O Builder:

•	 The Station window, where you place the modules for the station structure.
•	 The “Hardware Catalog” window, from which you select the required hardware 

components, e.g. Saia PCD®s, I/O modules and interface modules.

Displaying the hardware catalog

If the “Hardware Catalog” window does not display, select Window > Hardware 
Catalog. This menu option allows you to display or close down the hardware catalog.

2.2.1	 Basic steps to configure a station

Regardless of the underlying technology for a station (PCD2 or PCD3), you always 
follow the same steps to configure it:

1. Select a hardware component from the “Hardware Catalog” window.
2. Drag and drop the selected component into the Station window.

Alternatively, you can double-click on the component in the “hardware catalog”.

The screenshot below shows the basic operation:

Station window Catalog
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2.2.2	 Structure of the Station window

The Station window provides a detailed view of the installed Saia PCD®. It displays 
order numbers, a short description of the components and the addresses of the I/O 
modules in tabular form.

For a CPU equipped with I/O modules, the basic structure of the table is as follows:

	

2.2.3	 Configuration table as the map of a Saia PCD®

For the central assembly, you allocate the I/O modules clockwise around the CPU 
and then to the expansion device. The number of I/O modules that can be fitted is 
dependent on the CPU used.

Just as in your real system, you use the xx7 I/O Builder to place I/O modules on the 
Saia PCD®. The difference is that the CPU is represented in the xx7 I/O Builder by a 
configuration table, which has one row for every I/O module that can be plugged into 
the CPU.

The xx7 I/O Builder helps you to configure a station, in such a way that you generally 
receive immediate feedback where e.g. a module cannot be plugged into the desired 
socket. Address ranges are also checked automatically to ensure that the same 
addresses are not used twice.

You should pay attention to the messages displayed, which provide information on 
the causes and effects of an operation.

The screenshot below shows an example (PCD1.M137) of the implementation of a 
real assembly in the configuration table. The configuration table matches the CPU 
used.
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Please refer to the documentation and the latest product information on the modules.

2.2.4	 Specifying the properties of components

When you have allocated the modules in the Station window, you can double-click 
on the module to open a dialog box to change the preset properties (parameters or 
addresses).

Properties of CPUs

The properties of the CPUs have a particular bearing on the behavior of the system. 
In the dialog tabs for a CPU, you can set the SBC specific functions such as memory/
compiler settings, webserver settings, MPI via modem, properties of serial interfaces 
etc. These properties are stored in a CDB (Configuration Data Block). After every Po-
wer On, the CDB is re-analyzed and the parameterized system behavior is applied.

General CPU properties such as start-up behavior, local data areas and priorities for 
alerts, memory ranges, remanence behavior, timer impulses etc. are set using the 
hardware configurator within STEP®7.
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2.3	 Exporting a configuration

When the whole assembly has been configured with the xx7 I/O Builder, an AWL 
source has to be generated. This AWL source can be imported into STEP®7 for 
further processing.

Prerequisite

You must have opened an existing project or created a new project in the xx7 I/O 
Builder.

Before you can generate an AWL source, you must save the project. 

Procedure

1. Select the menu option Edit > Generate source...

	

2. The “DB compile” window opens.

	

Select the number of the hardware data block, and if necessary the number of the 
CDB data block.

3. When you click OK, the AWL sources will be generated. If the AWL sources are 
generated successfully, the following window appears:
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When the AWL source has been successfully generated, it is ready to be imported 
into STEP®7.

The AWL source is copied into the same directory the project was saved to.

 	 It is not allowed to change the numbers of these components later in SIMATIC Mana-
ger.

2.4	 Importing a configuration into STEP®7

2.4.1	 Generating a project in Simatic Manager

Procedure

1. Open Simatic®Manager.

	

 

2. Insert a SIMATIC 400 Station
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3. Select rack and power supply

	

To function correctly, the Simatic Manager needs a rack and a power supply. These 
details are not relevant to the Saia PCD® functionality.

The CPU is for the Saia PCD® Series xx7 (PCD2), which supports the CPU 414-1 ins-
truction set. The PCD1.M137 supports the CPU 412-1 instruction set.

4. Configuring the CPU

	

These settings are picked up by the Saia PCD® Series xx7 after downloading and 
subsequent start-up.
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5. Configuration of networks

Configuration of networks (Profibus, Ethernet etc.) is also handled by Simatic 
Manager. Further information can be found in manual “26/798 xx7 communication 
facilities”.

	

2.4.2	 Importing a configuration

Prerequisite

You must have generated an AWL source in the xx7 I/O Builder. The SIMATIC 
Manager must have been started and a project opened/created.

Procedure

1. Switch to the S7-Program/Sources directory.
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2. Select the menu option Insert > External Source...

	

The “Insert External Source” window opens.

3. Select and open the required AWL source. The new STL source appears in the 
component container.

 

4. Select the AWL source and translate it with menu option Edit > Compile.

Alternatively, you can press Ctrl+B.

5. If you now switch to the S7-Program/Blocks directory, you will find the hardware 
data block and the CDB (if this was selected in the xx7 I/O Builder).

	

This hardware data block must now be transferred to the Saia PCD® together with 
the remaining components. At a Stop→Run transition in the CPU, the hardware 
configuration will be analyzed and applied.
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2.5	 Summary: procedure for configuring a Saia PCD® Series xx7

The diagram below shows the basic procedure for configuring an assembly.

Select the Saia PCD® CPU and the Extension Boards

Select / Insert the  I/O-Modules

Set the properties of the I/O Modules

Set the properties of the Saia PCD® CPU

Save the  Configuration

Generate the STL-Source 

Import the STL-Source into SIMATIC Manager

Compile the STL-Source 

Load the HW-DB and CDB into the CPU

xx7 IO-Builder

Simatic Manager

The yellow boxes show the steps executed with the xx7 I/O Builder, while the blue 
boxes represent steps executed with STEP®7.

A new hardware configuration is analyzed and applied after a STOP → RUN transiti-
on in the Saia PCD®.
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3	 Configuring the hardware

3.1	 Rules for the allocation of modules

● Slot 0:	 Saia PCD® CPUs only (e.g. PCD2.M177)
● Slot A:	 Communication modules only (e.g. PCD7.F120), or not used
● Slot B1:	 Function modules only (e.g. PCD7.F520), or not used
● Slot B2:	 Function modules only (e.g. PCD7.F520), or not used
● Slots 1-64:	 I/O modules, intelligent I/O modules, or not used
● Slot +:	 Expansion devices, or not used

Depending on the Saia PCD® CPU used, not all slots will be available and visible. For 
the print option, Slots A/B1/B2 are used for information only; these fields can also be 
left blank.

3.2	 Generating a configuration

Prerequisite

You must have opened the xx7 I/O Builder.

Procedure

1. Select the menu option File > New, or the “New” icon.
2. The “Project Information” window opens. 

	

Complete the relevant fields as applicable. Confirm your input by clicking OK.

You can open this window and change your input at any time via the menu option 
Window > Project information.
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The details in the Name, Family and Author fields are picked up by the hardware data 
block / CDB under STEP®7. Within STEP®7, these details are displayed under object 
properties.

3.2.1	 Allocation of modules

Prerequisite

You must have created a new project with the xx7 I/O Builder.

Procedure

1. Select a component (e.g. a Saia PCD® CPU) from the “Hardware Catalog” window.
2. Drag and drop the component into the relevant row in the hardware configuration 

table. The xx7 I/O Builder checks whether any slot rules are being violated.

 	Symbol for a violation of slot rules.

3. Repeat steps 1 and 2 until the hardware configuration is equipped with the desired 
modules.

As an alternative to step 2, you can double-click on the component in the “Hardware 
Catalog”.

3.2.2	 Specifying the properties of modules/interfaces

For most modules, properties can be set (e.g. the base address).

Prerequisite

You must have set up at least one module with configurable properties in the Station 
window.

Procedure

Double-clicking on the module in the Station window opens the dialog box to change 
the module properties. The properties of the modules are covered in later sections.
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3.3	 Configuring the CPU

All CPU settings are stored in the Configuration Data Block (CDB). The possible set-
tings are dependent on the type of CPU. This manual gives a general overview of the 
possible settings. 

	 A detailed description of the individual functions can be found in manual “26/797 
Integrated system functions Series xx7”.

Double-clicking on the Saia PCD® CPU opens the Properties window.

Example: properties of the PCD2.M177

	

General tab

The General tab displays the name, the order number and the properties of the 
selected CPU. No settings can be entered in this tab.
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Memory/compiler tab

	

On the Memory/compiler tab, you can set the size of the STEP®7 user memory. You 
also have the option of setting the priorities of the components to be compiled.

Memory

In most Series xx7 controllers, the STEP®7 user memory is scalable. On this tab, the 
memory can be configured in 64kB steps.

The maximum memory size for the various controllers is shown in the table below: 

PCD type S7 code memory size
PCD1.M137 Default: 64 kB.

Configurable to 64 kB or 128 kB. 
PCD2.M127 Fixed 132 kB
PCD2.Mx57 Default: 256 kB.

Configurable from 64 kB to 512 kB. 
PCD2.M177 Default: 512 kB.

Configurable from 64 kB to 1024 kB.
PCD2.M487 Default: 1024 kB.

Configurable from 64 kB to 1024 kB.
PCD3.M5547 Default: 512 kB.

Configurable from 64 kB to 512 kB.
PCD3.M5447 Default: 512 kB.

Configurable from 64 kB to 512 kB.

On the PCD2.Mx57 and PCD2.M177 controllers, the whole user memory is split 
into S7 code memory and compiler memory. When allocating S7 code memory, it is 
important to note how much memory is left for the compiler code. The smaller the S7 
code memory, the larger the compiler memory.
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Where DB-Flash memory functionality is also used, the following should be noted: the 
larger the configured S7 code memory, the smaller the available DB flash memory.

	 Further information on memory settings can be found in manual “26/797 Integrated 
system functions Series xx7”, section 5 “Memory” and section 8.2 “Memory scaling”.

Compiler priority

With Saia PCD®s with an integrated compiler, an attempt is made at every Stop-Run 
transition to translate the whole STEP®7 program. As pre-set, components will be 
translated in the following sequence:

●	 FCs in descending order,
●	 FBs in descending order,
●	 OBs in descending order,
●	 SFCs in descending order (PCD3.M5x47 OEM only),
●	 SFBs in descending order (PCD3.M5x47 OEM only).

Where not all components can be compiled, the Compiler Priority field can be used 
to define a different sequence. If there is still space in the compiler memory after 
prioritized compilation, further components will be translated in the pre-set sequence.

Parameter:		  Component type.
‘*’ All components of the given type will be prioritized for 
compilation in ascending order. (Reverse of pre-set order) 
‘-’ Component range: If the higher component number is given 
first, the range will be compiled in descending order.

	 Further information on compiler priorities can be found in manual “26/797 Integrated 
system functions Series xx7”, section 8.3 “Priorities for compiling”.
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WEBserver tab

The PCD2.M157, PCD2.M177, PCD2.M487 and PCD3.M5x47 controls can be 
initialized to use the webserver by the configuration entered on this tab.

	

Index DB: This data block contains the list of all files loaded as data blocks into the 
xx7 controller.

RAM disk size: The default setting is 2 kB. This can be increased if required. On the 
PCD2.M157 and PCD2.M177, the additional RAM disk requirement is taken from 
Step®7 memory. On the PCD2.M487 and the PCD3.M5547, the additional memory 
requirement for the RAM disk is taken from the system memory.

Date format: By default, the webserver displays the date from the STEP®7 DATE_
AND_TIME (DT) variable as follows: DD.MM.YYYY (e.g. 23.11.2001). This format 
can be changed on the WEBserver tab.

Time format: By default, the web server displays the time from the STEP®7 DATE_
AND_TIME (DT) variable as follows: HH:MM:SS (e.g. 11:55:00). This format can be 
changed on the WEBserver tab.

Password: Specification of up to 4 passwords (4Level) separated by “,“. (, , = pla-
ce-holder). With the passwords, there is no distinction between upper and lower-ca-
se, e.g. “SBC” and “SBC” are the same password. Each password may be up to 16 
characters long. Spaces and commas may not be used. It is not necessary to define 
a password.
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Time-out for hang-up & password level reset: If no data is read or written by the 
WEBserver during this time-out time (entered in minutes), the passwords will be re-
set. If there is a modem connection to the WEBserver, the Saia PCD® will also termi-
nate this modem connection.

 	 Further information on the subject of the WEBserver can be found in manuals “26/775 
Webserver” and “26/797 Integrated system functions Series xx7”, section 8.5 “Web-
server”.

MPI tab

As well as the usual MPI interface, the PCD2 Series xx7 controllers can also 
be programmed via a serial user interface. This allows the serial interface to be 
connected directly to the PC for programming, without an MPI adapter. For this, the 
PC adapter must be set to the same baud rate in Simatic Manager as is set here 
(default: 19200).

By selecting MPI mode, any interface can be set to MPI protocol. If MPI mode is not 
selected, MPI protocol is always enabled on Port 1 (or Port 0 on the PCD2.M487 and 
PCD3.M5x47), at 19200 baud.

	

The following parameters can only be set if MPI mode has been selected. 

Communication by: RS-232 or modem. If communication via modem is selected, 
the Modem field will also be displayed.
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The initialization and configuration of the interface as a modem only allow the 
controller to be called. Outgoing calls are not possible. 

Protocol timing: The values for Character Delay Time (CDT) and Answer Delay 
Time (ADT) can be set for the communication protocol. If protocol timing is not 
selected, the following default settings are applied: 

		  Serial programming: 		  CDT = 220ms,		 ADT = 2000ms.
		  Programming via modem:	 CDT = 1s, 		  ADT = 10s.

Interface number: All serial interfaces can be initialized and configured as a 
programming interface. Only one interface can support the MPI protocol at any given 
time.

Baud rate: The baud rate must match the setting in the SIMATIC Manager: the 
default setting is 19200 baud.

Modem type: The T813 (analog modem) or the T850 (ISDN modem) may be 
selected.

Time-out for hang-up: The default setting is for an existing modem connection to 
be canceled automatically after 30 minutes if there is no traffic. This value can be 
changed using parameter type TIMEOUT. The timeout can be disabled with value 0.

 	 Further information on MPI settings can be found in manual “26/797 Integrated 
system functions Series xx7”, section 8.4 “Initialization of serial programming 
interface”.

Serial Interface tab

The serial interfaces on the F5xx modules (Slots B1 and B2) support a maximum 
baud rate of either 19200 or 38000 baud. This setting applies to both interfaces on 
the F5xx module.

This setting is not supported on the PCD1.M137.

	

	 Further information on maximum baud rates can be found in manual “26/797 
Integrated system functions Series xx7”, section 8.4.6 “Setting the max. baud rate on 
Slot B1 (B2)”.
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Start-up tab

On the PCD1 and PCD2.M1x7 systems, the I/O Reset signal is set during start-up. 
This means that OB100 cannot be used to access peripheral modules. On the PCD2.
M487 and the PCD3.M5x47, this signal is not set during start-up. With this tab, the 
user can set the start-up behavior for the M487 and the PCD3 to be the same as the 
older systems.

	

 	 Further information on the start-up behavior of the Saia PCD® can be found in manual 
“26/797 Integrated system functions Series xx7”, section 8.6 “Peripheral access in 
OB100”.

3.4	 Configuring digital input/output modules

The Properties window for digital input/output modules has two tabs: the General tab 
and the Addresses tab.

 	 Further information on the various digital input/output modules can be found in 
manual “26/757 Hardware for Series PCD1 and PCD2”, section 5 “Digital input/output 
modules”.

General tab

The General tab displays the name, the order number and the properties of the 
selected module. No settings can be entered in this tab.

Addresses tab

The Addresses tab can be used to enter the module start address. The end address 
is calculated automatically. If there are any address overlaps, the xx7 I/O Builder will 
alert you to this and display the next valid address.
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If the address range for the digital input modules is between 0 and 255, the input will 
be read cyclically and copied to the process map.

If the address range for the digital output modules is between 0 and 255, the values 
in the process map will be transferred cyclically to the module.

3.5	 Configuring analog input/output modules

The Properties window for analog input/output modules has three tabs: the General, 
Addresses and Measurement type tabs.

 	 Further information on the various analog input/output modules can be found in 
manual “26/757 Hardware for Series PCD1 and PCD2”, section 6 “Analog input/
output modules”.

General tab

The General tab displays the name, the order number and the properties of the 
selected module. No settings can be entered in this tab.

Addresses tab

The Addresses tab can be used to enter the module start address. The end address 
is calculated automatically. If there are any address overlaps, the xx7 I/O Builder will 
alert you to this and display the next valid address.

If the address range for the analog input modules is between 0 and 255, the input will 
be read cyclically and copied to the process map.

If the address range for the analog output modules is between 0 and 255, the values 
in the process map will be transferred cyclically to the module.

Measurement type tab

Depending on the analog module selected, this tab will offer the supported analog 
value formats for selection.

	

 	 The various analog value formats are covered in more detail in manual  “26/757 
Hardware for Series PCD1 and PCD2”, section 6 “Analog input/output modules”.
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3.6	 Configuring special modules

In the “Special Modules” catalog, the following module types can be found:

-	 Multi I/O modules
-	 Modems
-	 Modules from 3. manufacturers

	

No settings can be entered for the modems. They are only used as place-holders in 
the hardware configuration. The modem settings are copied to the CPU properties.

More detailed information on Ludwig modules can be found on the Ludwig company 
website: www.ludwig-systemelektronik.de.

3.7	 Configuring counter modules

The “Counter Modules” catalog contains the following module types:

-	 PCD2/3.H100 (counter module)
-	 PCD2/3.H110 (counter and meter module)
-	 PCD2/3.H150 (SSI module)

The Properties window for the PCD2/3.H100 module contains two tabs: the General 
tab and the Addresses tab.

The Properties window for the PCD2/3.H110 module contains five tabs: General, 
Addresses, Inputs, Outputs and Measurement.

The Properties window for the PCD2/3.H150 module contains three tabs: General, 
Addresses and Extras.

General tab

The General tab displays the name, the order number and the properties of the 
selected module. No settings can be entered in this tab.

http://www.ludwig-systemelektronik.de
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Addresses tab

The Addresses tab can be used to enter the module start address. The end address 
is calculated automatically. If there are any address overlaps, the xx7 I/O Builder will 
alert you to this and display the next valid address. If the address range is entered 
into the process map, the system does not read/write cyclically to/from the module. 
These modules can only be accessed via peripheral access commands.

Input tab (PCD2/3.H110 only)

The behavior of the inputs to the H110 module can be set via the Inputs tab.

	

Output tab (PCD2/3.H110 only)

The behavior of the outputs from the H110 module can be set via the Outputs tab.
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Measurement tab (PCD2/3.H110 only)

The various measurement modes for the H110 module can be configured via the 
Measurement tab.

	

Extras tab (PCD2/3.H150 only)

The various SSI parameters for the H150 module can be configured via the Extras 
tab. 

	

 	 Further information on the PCD2/3.H100 module can be found in the manual for the 
“PCD2.H100 (xx7/Step7)”.

 	 Further information on the PCD2/3.H110 module can be found in the manual for the 
“PCD2.H110 (xx7/Step7)”.

 	 Further information on the PCD2/3.H150 module can be found in the manual for the 
“PCD2.H150 (xx7/Step7)”.
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3.8	 Configuring positioning modules

In the “Special Modules” catalog, the following module types can be found:

-	 PCD2/3.H210 (1 axis stepper motor module)
-	 PCD2/3.H31x (1 axis servo motor module)
-	 PCD2.H32x (2 axis servo motor module)

The Properties window for the PCD2/3.H210 module contains two tabs: the General 
tab and the Addresses tab.

The Properties window for the PCD2/3.H31x module contains two tabs: the General 
tab and the Addresses tab.

The Properties window for the PCD2.H32x module contains four tabs: General, 
Addresses, X Axis and Y Axis.

General tab

The General tab displays the name, the order number and the properties of the 
selected module. No settings can be entered in this tab.

Addresses tab

The Addresses tab can be used to enter the module start address. The end address 
is calculated automatically. If there are any address overlaps, the xx7 I/O Builder will 
alert you to this and display the next valid address. If the address range is entered 
into the process map, the system does not read/write cyclically to/from the module. 
These modules can only be accessed via peripheral access commands.

X Axis/Y Axis tab (PCD2.H32x only)

These two axes can be operated with various encoders. The axis-specific settings 
can be entered under X/Y Axis.

	

 	 Further information on the PCD2/3.H210 module can be found in the manual for the 
“PCD2.H210 (xx7/Step7)”.
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 	 Further information on the PCD2/3.H31x module can be found in the “26/762  
PCDx.H31x manual”.

 	 Further information on the PCD2.H32x module can be found in the “26/778  
PCD2.H32x.xx7 manual”.

3.9	 Configuring communication modules

The “Communication Modules” catalog contains the interface modules for the serial 
interface on Slot A:

	

No properties can be set for the communication modules. They are only used as 
place-holders.

3.10	 Configuring function modules

The “Function Modules” catalog contains interfaces and field bus modules for Slots 
B1 and B2.

	

No properties for the function modules can be entered in the I/O Builder. They are 
only used as place-holders. Module-specific settings are entered directly in STEP®7. 

 	 Further information can be found in manual “26/798 xx7 communication facilities”.
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A	 Annex

A.1	 Icons

In manuals, this symbol refers the reader to further information in this manual or 
other manuals or technical information documents. 
As a rule there is no direct link to such documents.

This symbol warns the reader of the risk to components from electrostatic 
discharges caused by touch. 
Recommendation: Before coming into contact with electrical components, you 
should at least touch the Minus of the system (cabinet of PGU connector). It is 
better to use a grounding wrist strap with its cable permanently attached to the 
Minus of the system.

This sign accompanies instructions that must always be followed.

Clas
sic

Explanations beside this sign are valid only for the Saia PCD® Classic series.

xx
7

Explanations beside this sign are valid only for the Saia PCD® xx7 series.
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A.2	 Contact 

Saia-Burgess Controls AG 
Bahnhofstrasse 18 
3280 Murten 
Switzerland 

Phone...........................................  +41  26 672 72 72  
Fax................................................  +41  26 672 74 99 

Email support: ..............................  support@saia-pcd.com  
Supportsite: .................................  www.sbc-support.com  
SBC site: ......................................  www.saia-pcd.com  
International Represetatives &  
SBC Sales Companies: ...............  www.saia-pcd.com/contact 

Postal address for returns from customers of the Swiss Sales office

Saia-Burgess Controls AG 
Service Après-Vente  
Bahnhofstrasse 18 
3280 Murten  
Switzerland

mailto:support%40saia-pcd.com?subject=feedback%20from%20the%20manual%2026-835_EN02
http://www.sbc-support.com
http://www.saia-pcd.com
http://www.saia-pcd.com/contact
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